Anleitung fur den R-Server
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Allgemeine Einfuhrung

Der R-Studio-Server Professional, nachfolgend wird die Bezeichnung R-Server sowohl fiir die
Hard- als auch die Software als Gesamtsystem benutzt, bietet eine Entwicklungsumgebung
zur Statistiksoftware ,,R“.

Ergdanzende Tips und Anregungen sind eingeriickt und in kursiver Schrift gehalten.

Diese Anleitung geht davon aus, daf der Leser mit der Bedienung von R-
Studio grundlegend vertraut sei; es werden nur diejenigen Aspekte
behandelt, die iiber die Desktop-Version hinausgehen.

Es handelt sich hierbei um eine Client-Server-Architektur, d.h. der lokale Arbeitsplatz wird
nur zur Ein- und Ausgabe verwendet, alle Berechnungen finden jedoch auf dem Server statt.
Ebenso liegen das Programm ,,R“ samt seiner installierten Pakete sowie die Scripte der
Anwender zentral auf dem Serversystem.

Da alle Rechenleistung vom Server erbracht wird, kann das Clientsystem auch
leistungsschwach sein, z.B. ein Tablettcomputer.

Getestet wurden folgende Betriebssystem/Browser-Kombinationen:
*  Windows/Mozilla
* Mac OSX/Safari

Viele weitere Kombinationen sind wahrscheinlich méglich, wurden aber
bisher noch nicht ausgetestet.

Starten der Verbindung

Méc
[ NON ] 2] & 134.100.87.141:8787 @ Upd:
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Apple iCloud Yahoo Bing Google Wikipedia

In einem Standardbrowser wird die IP-Adresse des RStudio-Servers eingegeben: die Adresse
lautet 134.100.87.141:8787

Wichtig hierbei ist, dald die Portnummer 8787 nach einem Doppelpunkt eingegeben werden
mul3! Der R-Server ist ndmlich kein Standard-Webserver und benotigt auch keinen als Basis.
Im Prinzip kdnnte auf den R-Server weltweit zugegriffen werden, allerdings kann das
eingeschrankt werden.

Hinweis: Unter Windows wird von der Verwendung des Internet Explorers
dringend abgeraten, da dieser erfahrungsgemdif3 bei Java und JavaScript
gerne Kompatibilitéitsprobleme hat. Stattdessen sollte der Firefox von
Mozilla verwendet werden.

Es erscheint der Anmeldebildschirm:



134.100.87.141 &

OStudio

Username:
testuser4

Password:

Stay signed in

Sign in to RStudio

| 3%

Hier sind nun der Benutzername und das PaBwort einzugeben.

Jeder Benutzer benétigt eine Kennung. Masterstudenten und Mitarbeiter

erhalten eine persénliche Kennung; Kursteilnehmer fragen bitte den

jeweiligen Dozenten.

Das PafSswort ist nur fiir dieses System und derzeit mit keinem anderen

Pafiwort an der UniHH synchronisiert. Das PafSwort kann durch den
Benutzer derzeit nicht gedindert werden.

Es erscheint der Hauptbildschirm:

0O < [im} 134.100.87.141

@ File Edit Code View Plots Session Build Debug Profile Tools
Qlvicp~ -+ ~ Addins ~

Console - -~

R version 3.3.2 (2016-10-31) -- "Sincere Pumpkin Patch"
Copyright (C) 2016 The R Foundation for Statistical Computing
Platform: x86_64-suse-linux-gnu (64-bit)

R ist freie Software und kommt OHNE JEGLICHE GARANTIE.
Sie sind eingeladen, es unter bestimmten Bedingungen weiter zu verbreiten.
Tippen Sie 'license()' or 'licence()' fiir Details dazu.

R ist ein Gemeinschaftsprojekt mit vielen Beitragenden.

Tippen Sie 'contributors()' fiir mehr Information und 'citationQ)',

um zu erfahren, wie R oder R packages in Publikationen zitiert werden kénn
en.

Tippen Sie 'demo()' fur einige Demos, 'help()' fiir on-line Hilfe, oder
'help.start()' fir eine HTML Browserschnittstelle zur Hilfe.
Tippen Sie 'q()', um R zu verlassen.

WARNING: You are configured to use the CRAN mirror at https://cran.rstudio
.com/. This mirror supports secure (HTTPS) downloads however your system i
s unable to communicate securely with the server (possibly due to out of d
ate certificate files on your system). Falling back to using insecure URL
for this mirror.

To learn more and/or disable this warning message see the "Use secure down
load method for HTTP" option in Tools -> Global Options -> Packages.
>

¢ 6o

Help testuser4 |+  Sessions v . ®

& Project: (None) + R3.3.2 ~

Environment  History |
# [J _#ImportDataset + 3 List +

7} Global Environment ~

Environment is empty

Files Plots Packages Help Viewer P |
@ New Folder ) Upload @ Delete « Rename ¥ More ~
/.\ Home
A Name Size Modified
. bin
() public_html
@l R




Dieser Bildschirm sieht dem ,,normalen” R-Studio zum Verwechseln dhnlich. Und er
funktioniert — von einigen wenigen Ausnahmen abgesehen —auch genau so. Jeder, der
schon einmal mit R-Studio gearbeitet hat, wird sich sofort zurechtfinden.

Eine Besonderheit ist, daR sich die Dateien unter Files nicht auf dem Rechner befinden, vor
dem man sitzt, sondern auf dem R-Server. D.h. man hat seine Dateien immer dabei.

Files zeigt das personliche Homeverzeichnis, auf welches nur der Benutzer selbst Zugriff hat.
Das Dateisystem ist am Anfang nahezu leer, aber es konnen Dateien oder auch Ordner in
einer beliebigen Strukturtiefe erzeugt werden.

Files Plots Packages Help Viewer [

| New Folder &/  Upload @  Delete (=] Rename = 4k More ~
/.\ Home R
A Name Size Modified
t.

Il packages

Im Ordner R befindet sich ein Unterordner packages. Hier wird der R-Server die Packages
installieren, die der Benutzer selbst heruntergeladen und installiert hat.

Es ist nicht empfehlenswert, von Hand in dem Ordner ,,packages” Dateien
zu kopieren, zu léschen oder zu bearbeiten. Diese Aufgabe sollte dem R-
Server liberlassen bleiben.

Dateien zum Server hochladen

Selbstverstandlich lassen sich Dateien vom Arbeitsrechner in das persoénliche
Homeverzeichnis des Servers ganz einfach hochladen. Hierfiir wird im Fenster Files einfach
auf den Button Upload geklickt.

Tippen Sie contr'_tbutors() fur mehr Upload Files
um zu erfahren, wie R oder R package r

S Target directory: | Packages Help Viewer P |

q q e A Q Q - &
Tippen Sie 'demo()' fiir einige Demos ‘) Home | . Upload @ Delete 4 Rename  {GF More

'help.start()' flr eine HTML Browser File to upload: B

Tippen Sie 'q()', um R zu verlassen. : ime Size Modified
Datei auswahlen Testdatei

WARNING: You are configured to use t

-com/. This m1rr‘0r‘suppor‘ts secur‘eA a TIP: To upload multiple files or a directory, create a zip file.

s unable to communicate securely witl | The zip file will be automatically expanded after upload.

ate certificate files on your system

for this mirror.

c_html

| OK | Cancel

To learn more and/or disable this warntng Seethe "Use secure down v
load method for HTTP" option in Tools -> Global Options -> Packages.

Nun wird mit dem Button Datei auswdhlen die entsprechende Datei ausgewahlt. Als Ziel ist
automatisch das eigene Homeverzeichnis voreingestellt. Mit OK wird die Datei kopiert.



Files Plots Packages Help Viewer ]

& | New Folder Upload €@ Delete .« Rename .f More ~

/.\ Home
A Name Size Modified
is 1 [ bin
:z "' ) public_htm|
(IR
g _| Testdatei.txt 12 B Jan 18, 2017, 5:50 PM
0

Die Datei , Testdatei.txt“ wurde erfolgreich hochgeladen und erscheint nun im Fenster.

Dateien vom Server herunterladen

Ebenso einfach kénnen Dateien vom Server auf den lokalen Arbeitsplatzrechner
heruntergeladen werden.

Files Plots Packages Help Viewer ——

& | New Folder &/ Upload @ Delete % Rename = {¥ More ~

42} Home
.
! Copy... L
A Name dified
. . ' Move... '
[l bin
[l public_html Export...
&l R Set As Working Directory

Zunachst wird die entsprechende Datei markiert, indem das Kastchen angeklickt wird. Der
Download wird unter R-Server als ,,Export” bezeichnet und befindet sich im Men unter
More.




® 0  Testdatei2.txt -
Hello world

Die Datei wurde erfolgreich heruntergeladen. Hier hat das Betriebssystem die Datei auch
gleich gedffnet.

Auswahl der R-Version

Eine Besonderheit des RStudio-Server Pro ist die Moglichkeit, verschiedene R-Versionen
parallel benutzen zu kénnen. Diese missen aber aus den Quellen selbst compilkert werden,
was entsprechend zeitraubend ist.

In der rechten oberen Ecke des Hauptfensters wird die aktuell verwendete R-Version
angezeigt.

-

0O < Em] 134.100.87.141 & (V) a +

@ File Edit Code View Plots Session Build Debug Profile Tools Help testuser4 | - Sessions v ®

Qlvlc~ |~ Addins ~ & Project: (None) v R3.3.2

{

Console ~/ ()} Environment Histor? v Rversion 3.3.2 /usr/lib64/R h
2 [ _#ImportD R version 3.2.5 /opt/R/3.2.6/lib64/R |

R version 3.3.2 (2016-10-31) -- "Sincere Pumpkin Patch" N | . : |

. . c s . Global Ei t R 3.2.5 R/3.2.5/lib64/R

Copyright (C) 2016 The R Foundation for Statistical Computing _Co L version [opt/R] N4/ ]
Platform: x86_64-suse-linux-gnu (64-bit) 1 Rversion 2.15.3  /opt/R/2.15.3/lib64/R ;
Files Plots Packages Help Viewer - ]

R ist freie Software und kommt OHNE JEGLICHE GARANTIE.
Sie sind eingeladen, es unter bestimmten Bedingungen weiter zu verbr | Install @ Update
eiten. Name Description Versi...

Tippen Sie 'license()' or 'licence()' fur Details dazu. User Library

darts Statistical Tools to Analyze Your 1.0

R ist ein Gemeinschaftsprojekt mit vielen Beitragenden.
Darts Game

Tippen Sie 'contributors()' fir mehr Information und 'citation()',
um zu erfahren, wie R oder R packages in Publikationen zitiert werde System Library

n konnen. abind Combine Multidimensional Arrays 1.4-5
. . " - " . . acepack ACE and AVAS for Selectin 1.4.1
Tippen Sie 'demo()' fur einige Demos, 'help()' fur on-line Hilfe, od P Multiple Regression 9

er

Ein Klick auf den Pfeil zeigt die verfligbaren Versionen an, sowie die Lage ihrer
Hauptverzeichnisse.

Derzeit ist die 3.3.2 die Hauptversion. Bei einem Update kann die
Hauptversion auf einen neueren Stand gebracht werden, ohne dafs die



Pakete neu installiert werden miissen. Allerdings kann man sich nicht
darauf verlassen, daf8 die Hauptversion auf genau diesem Versionsstand

bleibt.

Durch einfaches Klicken mit der Maus kann die Version innerhalb von Sekunden gewechselt

werden.
000 < M 134.100.87.141 ¢ O | O [E
I
@ File Edit Code View Plots Session Build Debug Profile Tools Help testuser4 Sessions v ®
Q- ~ ~  Addins ~ & Project: (None) + R 2.15.3 ~
Console ~/ =) Environment = History o |
¥ [ #Import Dataset ~ 3 List v | (&

ISBN 3-900051-07-0
Platform: x86_64-unknown-linux-gnu (64-bit)

eiten.

n koénnen.

er
Tippen Sie 'q()', um R zu verlassen.

> |

R version 2.15.3 (2013-03-01) -- "Security Blanket"
Copyright (C) 2013 The R Foundation for Statistical Computing

R ist freie Software und kommt OHNE JEGLICHE GARANTIE.
Sie sind eingeladen, es unter bestimmten Bedingungen weiter zu verbr

Tippen Sie 'license()' or 'licence()' fiir Details dazu.
R ist ein Gemeinschaftsprojekt mit vielen Beitragenden.

Tippen Sie 'contributors()' fur mehr Information und 'citation()',
um zu erfahren, wie R oder R packages in Publikationen zitiert werde

'help.start()' fiur eine HTML Browserschnittstelle zur Hilfe.

Tippen Sie 'demo()' fur einige Demos, 'help()' fir on-line Hilfe, od

"} Global Environment =

Files Plots Packages Help Viewer |
0 Install @ Update

Name Description Versi...
User Library

darts Statistical Tools to Analyze Your 1.0
Darts Game

System Library

boot Bootstrap Functions (originally by 1.3-7
Angelo Canty for S)
class Functions for Classification 7.3-5
cluster Cluster Analysis Extended 1.14.3
Rousseeuw et al.
codetools Code Analysis Tools for R 0.2-8
compiler The R Compiler Package 2.15.3
datasets The R Datasets Package 2.15.3
foreign Read Data Stored by Minitab, S, 0.8-
SAS, SPSS, Stata, Systat, dBase, ... 52
graphics The R Graphics Package 2.15.3
grDevices The R Graphics Devices and 2.15.3
Support for Colours and Fonts
— grid The Grid Graphics Package 2.15.3
KernSmooth  Functions for kernel smoothing 2.23-
for Wand & Jones (1995) 8
lattice Lattice Graphics 0.20-
13
MASS Support Functions and Datasets 7.3-
for Venables and Ripley's MASS 23
Matrix Sparse and Dense Matrix Classes  1.0-

and Methods 11

Hier wurde auf die Version 2.15.3 umgestellt.

Selbstverstandlich kann die Auswahl auch permanent getroffen werden. Unter Tools den
Punkt Global Options wahlen. Die Auswahlmaoglichkeiten befinden sich im Bereich unter

III

,Genera




Options
) Default version of R:  (Use System Default) | < K
I (ERWY

General v/ Restore last used R version for projects

Default working directory (when not in a project): |

Code

=/

Appearance Show server home page: Multiple active sessions u

~ ‘ Browse...

v/ Re-use idle sessions for project links

Pane Layout V| Restore most recently opened project at startup

I V| Restore previously open source documents at startup
Packages

v/ Restore .RData into workspace at startup |
Rmd, . |
. Save workspace to .RData on exit: Ask [T}
R Markdown
Q= v/ Always save history (even when not saving .RData)
Sweave Remove duplicate entries in history |
3 1
7 Show .Last.value in environment listing
Spelling Run Rprofile when resuming suspended session
Git/SVN v/ Use debug error handler only when my code contains errors |
o Automatically expand tracebacks in error inspector |
& {
Publishing ‘

OK Cancel Apply

Die Voreinstellung (Use System Default) bedeutet, daB der Anwender stets die Version
verwendet, die beim R-Server als Hauptversion eingestellt ist.

Naturlich lassen sich die Voreinstellungen wahrend der Benutzung jederzeit auch manuell
Uberschreiben.

Manche Anderungen der Voreinstellungen werden erst bei der néchsten
Anmeldung wirksam.



Packages installieren

Inzwischen werden mehr als 9000 Pakete fiir R angeboten, die leider nicht alle auf dem R-
Server installiert sein konnen, weil hierfir der Plattenplatz nicht ausreichen wiirde.

Bei der Installation von Paketen miissen grundsatzlich zwei Typen unterschieden werden:
1 Pakete nur fiur den Benutzer, der sie installiert hat, und
2 Pakete fir alle Benutzer, die zentral installiert werden.

Im Falle von Paketen, die fiir Unterrichtszwecke benétigt werden, wird
dringend empfohlen, daf$ der Dozent diese zundichst unter seiner
persénlichen Kennung installiert und testet (Typ 1), bevor die Anforderung
an den Administrator weitergeleitet wird. Die anschliefSende Installation
vom Typ 2 bietet jedoch den enormen Vorteil, daf$ die gewiinschten Pakete
sofort fiir alle Benutzer — und damit auch die Teilnehmer des Kurses -
verfiigbar sind.

Installation eines Benutzer-Paketes

000 < 0 134.100.87.141 ¢ [V O |
@ File Edit Code View Plots Session Build Debug Profile Help testuser4 Sessions » ®
Ol v Addins | &1 |nstall Packages... L Project: (None) v = R3.3.2 ~
|
Console ~/ =) @ Check for Package Updates... -

Version Control » List ~
R version 3.3.2 (2016-10-31) -- "Sincere Pumpkin Patch" |

Copyright (C) 2016 The R Foundation for Statistical Computing Shell...
Platform: x86_64-suse-linux-gnu (64-bit)

Addins >
. . wer e |
R ist freie Software und kommt OHNE JEGLICHE GARANTIE. Keyboard Shortcuts Help XK |
S}e sind eingeladen, es unter bestimmten Bedingungen weiter zu verbr Modify Keyboard Shortcuts... | -
eiten. | Versi...
Tippen Sie 'license()' or 'licence()' fir Details dazu. Project Options... 38,
R ist ein Gemeinschaftsprojekt mit vielen Beitragenden. Global Options... 3, lensional Arrays  1.4-5
Tippen Sie 'contributors()' fir mehr Information und 'citation()', Tracepack ACE ana AVASTor Selecting 1.4.1
um zu erfahren, wie R oder R packages in Publikationen zitiert werde Multiple Regression
n kénnen. Transformations
ade4 Analysis of Ecological Data : 1.7-5
. M v oen - ' v oen R . Exploratory and Euclidean
Tippen Sie 'demo()' fur einige Demos, 'help()' fir on-line Hilfe, od Methods in Environmental
er Sciences
_help.sfgrtg)”fur eine HTML ?r‘owserschmttstelle zur Hilfe. adehabitatlT Analysis of Animal Movements 03.21

Zunachst sind einige Vorbereitungen zu Treffen. Unter Tools wird wieder Global Options
gewadhlt, um einige grundlegende Voreinstellungen im Bereich ,,Packages” zu treffen.




Options

( ‘ Package managem Saving...
I General CRAN mirror:
1 ‘Global (CDN) - RStudio Change...
¢ Code v|Enable packages pane

’j Use secure download method for HTTP ?
( Appearance

Package development

I v/ Use devtools package functions if available

‘ Pane Layout
t Save all files prior to building packages

’ v| Automatically navigate editor to build errors
Packages H

. v/ Hide object files in package src directory |
Rmd |
R Markdown v/ Cleanup output after successful R CMD check
- View Rcheck directory after failed R CMD check |
@2
Sweave v/ Use Rcpp template when creating C++ files
|
ll g v/ Always use LF line-endings in Unix Makefiles
|
| Spelling ? Developing Packages with RStudio [
L |
Git/SVN
= ;
Publishing |

OK Cancel Apply

Ganz wichtig ist, dal? der Haken fiir Use secure download method for http entfernt wird! So
dann ist ein CRAN-Mirror zu wahlen. Hier bietet sich die Uni Minster an, weil die innerhalb
des DFN liegt und damit der Download entsprechend schnell ist.

. Install Packages

Install from: ? Configuring Repositories ¢
Repository (CRAN) ﬂ

Packages (separate multiple with space or comma):

n
e

darts ‘ |

Install to Library: |
£ /home/testuser4/R/packages [Default]

o)

v Install dependencies

4
£ | Install Cancel i
l -

Hier soll das Paket ,darts” installiert werden. Liegt das Paket schon als Datei vor, so kann
dies unter Install from entsprechend ausgewahlt werden.



00O < Em] 134.100.87.141 ¢ (4] 2 |[F

@ File Edit Code View Plots Session Build Debug Profile Tools Help testuser4 | =+ Sessions v ®
Ql-| -~ ~ ~ Addins ~ & Project: (None) ~ | R3.3.2 ~
Console ~/ = Environment  History P o |
Installing package into ‘/home/testuser4/R/packages’ % [ _#ImportDataset + 3 List ~

(as ‘lib’ is unspecified)
versuche URL 'http://cran.rstudio.com/src/contrib/darts_1.0.tar.gz'
Content type 'application/x-gzip' length 7011 bytes

"} Global Environment ~

Files Plots Packages Help Viewer o |
downloaded 7011 bytes
| Install @ Update
* installing *source* package ‘darts’ ... Name Description Versi...
** libs A A A User Library
gcc -std=gnu99 -I/usr/1ib64/R/include -DNDEBUG -I/usr/local/include o
-fpic -fmessage-length=0 -grecord-gcc-switches -fstack-protector -0 darts SDI::tI:“GC:r;EOOIS to Analyze Your 1.0
2 -Wall -D_FORTIFY_SOURCE=2 -funwind-tables -fasynchronous-unwind-ta
bles -c darts.c -o darts.o System Library
gcc -std=gnu99 -shared -L/usr/1ib64/R/1ib -L/usr/local/1ib64 -o dart abind Combine Multidimensional Arrays 1.4-5
S.so dar.‘ts.o -L/usr/1ib64/R/1ib -1R . acepack ACE and AVAS for Selecting 1.4.1
installing to /home/testuser4/R/packages/darts/1libs Multiple Regression
** R ) ) Transformations
** preparing package for lazy loading ade4 Analysis of Ecological Data : 1.7-5
** help Exploratory and Euclidean
*** installing help indices Methods in Environmental
** puilding package indices Sciences
** testing if installed package can be loaded adehabitatLT Analysis of Animal Movements 0.3.21
* DONE (darts) adehabitat... Tools to Deal with Raster Maps 0.3.11
Amelia A Program for Missing Data 1.7.4
The downloaded source packages are in —— 9 — 9 -
¢ /tmp/RtmpdxYdqt/downloaded_packages’ animation A Ggl[ejy of Amr_n_apons in 2.4
Statistics and Utilities to Create
Warnmeldungen: Animations
1: In download.file(mirrors_csv_url, destfile = mirrors_csv, quiet = .
ape Analyses of Phylogenetics and 4.0
TRUE) ' ) ) , , Evolution
URL 'https://cran.r-project.org/CRAN_mirrors.csv': status was 'Pee aplpack Another Plot PACKage: stem.leaf, 1.3.0

r certificate cannot be authenticated with given CA certificates' bagplot, faces, spin3R

2: In download.file(mirrors_csv_url, destfile = mirrors_csv, quiet = plotsummary, plothulls, and
TRUE) : some slider functions
URL 'https://cran.r-project.org/CRAN_mirrors.csv': status was 'Pee arm Data Analysis Using Regression 1.9-3
r certificate cannot be authenticated with given CA certificates' and Multilevel/Hierarchical
N Models
aceartthat Eacyve nro an A nact accartinne nAa

Im Fenster Console kann man sehen, wie das Paket heruntergeladen und anschlieBend
compiliert wird. Die Zeile * DONE (darts) zeigt an, dal} es erfreulicherweise geklappt
hat. Im Fenster Packages ist das neue Paket unter User Library zu sehen.

Vom Benutzer als User Library installierte Pakete kénnen in allen R-
Versionen verwendet werden.

Das bedeutet aber nicht, dafs die Pakete in allen Versionen von R auch
funktionieren, denn das ist von den Paketen selbst abhéingig!

Files Plots Packages Help Viewer =]
& |New Folder &/ | Upload @  Delete '« Rename & ik More ~ (=
4 Home R packages

A Name Size Modified

t

[l darts

Im Fenster Files kdnnen wir im Ordner R/packages sehen, dal® das neue Paket darts hier
installiert wurde.



00 < il 134.100.87.141 ¢ © & g |3

@ File Edit Code View Plots Session Build Debug Profile Tools Help testuser4 Sessions v

Q- -~ ~~ ~ Addins ~ & Project: (None) » | R3.3.2

Console ~/ m) Environment  History |
% [ _#Import Dataset ~ 3 List ~

R version 3.3.2 (2016-10-31) -- "Sincere Pumpkin Patch"
Copyright (C) 2016 The R Foundation for Statistical Comput

ing Files Plots Packages Help Viewer |
Platform: x86_64-suse-linux-gnu (64-bit)

"}, Global Environment ~

1 Install @ Update

R ist freie Software und kommt OHNE JEGLICHE GARANTIE. Name Description Ver...
Sie sind eingeladen, es unter bestimmten Bedingungen weite

R User Library
r zu verbreiten. _
Tippen Sie 'license()' or 'licence()' fir Details dazu. darts Statistical Tools to Analyze 1.0
Your Darts Game
R ist ein Gemeinschaftsprojekt mit vielen Beitragenden. System Library
Tippen Sie 'contributors()' fir mehr Information und 'cita abind Combine Multidimensional 1.4-
tionQ)"', Arrays 5
um zu erfahren, wie R oder R packages in Publikationen zit acepack ACE and AVAS for Selecting 1.4.1
iert werden kénnen. Multiple Regression
Transformations
Tippen Sie 'demo()' fur einige Demos, 'help()' fur on-line ade4 Analysis of Ecological Data  1.7-
Hilfe, oder : Exploratory and Euclidean 5
"help.start()' fiir eine HTML Browserschnittstelle zur Hilf gﬂ?thOdS in Environmental
ciences
e.
Tippen Sie 'q()', um R zu verlassen. adehabi... :/Ir;ilzs:z:tfsAmmal 0.3.21
> library("darts", lib.loc="/usr/1ib64/R/library") adehabi... I,I‘;‘F’)': to Deal with Raster  0.3.11

> library("darts", 1lib.loc="~/R/packages™)

S Amelia A Program for Missing Data 1.7.4

animation A Gallery of Animations in 2.4
Statistics and Utilities to

Die Pakete lassen sich wie in R (iblich verwenden. Auf dem hier gezeigten System ist das
Paket ,, darts” in zwei Versionen vorhanden. Die obere Zeile l1adt das zentral gespeicherte
Paket und die untere Zeile das durch den Benutzer installierte Paket.

Es kann vorkommen, dafs eine ganz bestimmte (z.B. dltere) Version eines
Paketes bendtigt wird. Auf diese Weise kann die Verwendung der richtigen
Version sichergestellt werden.

Zentrale Installation eines Paketes

Pakete vom Typ 2 kdnnen derzeit nicht Uber die grafische Oberflache installiert werden,
sondern nur durch den Administrator. Pakete vom Typ 2 missen zudem fiir jede gewlinschte
R-Version separat installiert werden; das ist zwar umstandlich, ermoglicht aber
unterschiedliche Paket-Versionen fiir unterschiedliche R-Versionen.



Session Management

Flr den R-Server ist Session ein zentraler Begriff. Eine Session ist sozusagen eine einzelne
Programmausfiihrung von R, der Server kann eine Vielzahl von Sessions parallel ausfiihren,
da er Uber leistungsstarke Ressourcen verfligt. Jede Session verwendet ihren eigenen
Speicherbereich und nutzt auch Kopien der Bibliotheken, so dal8 keine Interaktion zwischen
den einzelnen Sessions stattfindet.

Startet ein Benutzer jedoch mehrere Sessions, so muR er selbst darauf achten, daR diese
nicht Probleme beim Einlesen der Daten oder beim Abspeichern der Ergebnisse bekommen,
wenn auf dieselben physischen Dateien zugegriffen wird.

Eine Session lauft auf dem R-Server weiter, auch wenn der Benutzer das Clientsystem
abschaltet oder die Verbindung abbricht. Das ist sehr niitzlich, weil der Benutzer mit seinem
Clientsystem ohne Belastung durch R weiterarbeiten kann, wahrend gleichzeitig der Server —
quasi im Hintergrund — komplexe Berechnungen durchfiihrt.

Es ist wichtig, dafs die Benutzer Sessions, die nicht mehr gebraucht werden,
auch wirklich beenden, weil nur so alle Ressourcen wieder freigegeben
werden.

Session starten

Die erste Session wird automatisch beim ersten Anmelden gestartet. Je nach
Voreinstellungen ,erkennt” der Server auch eine bereits friiher gestartete Session und stellt
diese automatisch wieder her.

testuser2 Sessions (2) = @ i

& Project: (None) ~ R2.15.3 « \

Eine weitere Session wird gestartet, indem auf das Symbol “— geklickt wird.
New R Session (
| 1
| Start within: ©Working Directory Project ‘
' Directory: ~ Browse...
R version: R version 3.3.2 (/usr/lib64/R) 1T} |
i
| Start |  Cancel |

Jetzt kann die R-Version gewahlt werden, allerdings ist eine Anderung auch spater noch
jederzeit moglich.

Dann kann noch gewadhlt werden, ob ein Verzeichnis oder ein Projekt ge6ffnet werden soll.
Mit einem Klick auf Start wird dann die neue Session gestartet und geoffnet.



Session wechseln/anzeigen

testuser? Sessions (2) = O]

K Project: (None) + R2.15.3 =

Um zu einer anderen Session zu wechseln, wird in der oberen rechten Ecke auf den Pfeil
hinter Session geklickt. Dem Benutzer wird jederzeit die Anzahl seiner Sessions angezeigt.

34.100.87.141 & O h &l

+
1g Profile Tools Help testuser2 Sessions (2) » ® .
v Addins - U (Home) ® v
_ — 52.15.3 =
Idle [
File -
ng €) (Home) 7 @ |
R3.3.2 |
Use| Idle

b /. Open All Sessions
zu verbr
System Library

(RO [ PR Fovmctimms facici;all. be. 12 7

Hier hat der Benutzer zwei Sessions gleichzeitig gestartet. Die oberste ist immer die, die
gerade im Client angezeigt wird. Hier sieht man auch schon, daR der Benutzer in den
Sessions unterschiedliche R-Versionen gleichzeitig nutzt.

Eine andere Session wird nun durch einfaches Klicken in die gewiinschte Session ausgewahlt.

Wird jedoch das Symbol ' angeklickt, so 6ffnet sich die Session in einem weiteren
Fenster.

RStudio




Session beenden

Wie gesagt, sollten nicht mehr bendétigte Sessions beendet werden, um alle Ressourcen des
Servers wieder flr andere Benutzer verfligbar zu machen.

Die derzeit angezeigte Session kann jederzeit mit einem Klick auf das Symbol ' beendet
werden. Hat der Benutzer noch weitere aktive Sessions, so landet er auf dem
Startbildschirm.

34.100.87.141 & O 0 3 [

ig Profile Tools Help testuser2 Sessions (2)

~ Addins ~ €) (Home) v

2.15. I
il R 2.15.3 =

Idle
File, [

ng €) (Home)
R3.3.2

Use| Idle

Open All Sessions
zu verbr ~
System Library

[ [ PSPPI R S R S S | R T e

In der Session-Liste kann jede Session mit einem Klick auf das Symbol “~ beendet werden.
Hat der Benutzer noch weitere aktive Sessions, so landet er auf dem Startbildschirm.



[ XON ) Em] 134.100.87.141 ¢ O M O
RStudio RStudio RStudio Server
RStudio Server Pro testuser2
ACTIVE SESSIONS ~ +
€ (Home) ® € (Home) ®
R3.3.2 R 3.3.2
Idle Idle
R PROJECTS Open Project % New Project » HELP
Recent Projects Directory Last Used Owner R’ R Resources

Learning R Online
CRAN Task Views
R on StackOverflow
Getting Help with R

@ Rstudio

RStudio IDE Support
RStudio Cheat Sheets
RStudio Tip of the Day
RStudio Packages
RStudio Products

No projects found.

Create a new project, or learn more about using projects in RStudio.

Hier kann er z.B. zu einer seiner weiteren Sessions wechseln, oder auch eine neue Session
starten.

Es ist nicht méglich, sich eine Session in mehr als einem Fenster gleichzeitig
anzeigen zu lassen. Der R-Server erkennt den Konflikt und suspendiert
jeweils eine der Verbindungen.

Abmelden/Beenden

Der angemeldete Benutzer kann sich jederzeit vom R-Server abmelden, indem das Symbol

angeklickt wird. Alternativ kann auch gleich das Browserfenster geschlossen werden.
Hierbei werden jedoch alle Sessions abgemeldet.

Die Abmeldung ldfst jedoch alle Sessions im Hintergrund weiterlaufen. Eine
Abmeldung bedeutet nicht, eine Beendigung der Sessions.

Vergleichbar wdre dies mit dem Abschalten des Bildschirmes bei einem PC,
der trotzdem weiterlduft und Berechnungen durchfiihren kann.



Zusammenarbeit an einem Projekt

Eine der wichtigsten Funktionen von R-Server ist die Moglichkeit, dalR mehrere Benutzer
gemeinsam an einem Projekt arbeiten konnen. Diese Moglichkeit gibt es bei der ,,normalen”
Version von R-Studio nicht.

Der R-Server libernimmt hierbei das Management der Dateien, so daR tatsachlich mehrere
Benutzer gleichzeitig mit der Originaldatei arbeiten kdnnen. Die Benutzer missen sich auch
um nichts kimmern, weil der R-Server die gesamte Dateiverwaltung Gibernimmt.

(4

Projekt freigeben

Im folgenden Beispiel méchte der Benutzer ein Projekt mit dem Namen WirZusammen
freigeben.

R & Project: (None) ~ R33.2 ~

Environment R New Project...

r =5

1M <% Open Project... e
Global Enviro

-

Close Project

WirZusammen

Files Plots testprojekt
nstall @ Clear Project List :
Name Versi...
Project Options... 188,

User Library

darts Statistical Tools to Analyze Your 1.0

Zunachst ist das gewlinschte Projekt auszuwahlen, indem in der rechten oberen Ecke mit
einem Klick auf den Pfeil hinter Project das Men aufgerufen wird.

Open Project

l Shared with Me
Project file: |WirZusammen
/.\ Home
bin
public_html
R
testprojekt

WirZusammen

Open project in new session | Open Project | Cancel

Das gewlinschte Projekt wird ausgewadhlt und auf Open Project geklickt.



Project Options

= Shared With:
General
Code Editing
e
Sweave
AN
Build Tools
Git/SVN
Packrat | testuser
2 testuserl
S [ testuser2 y4eec1b9b0aSec8bff051/
aring
| testuser3 s project by opening the URL.
( testuser5 sermissions that you do on all of the
projects Ties.
? Project Sharing

oK Cancel

Nun kann in dem Pull-Down-Menii in der Mitte der Benutzer ausgewahlt werden, dem die
Zusammenarbeit gestattet werden soll. Hier wird der testuser5 ausgewahlt und mit Add
hinzugefugt.

Unten wird die URL angezeigt, mit der der R-Server das Projekt verwaltet. Den Pfad zu den
Originaldateien bekommen die Teilnehmer nicht zu sehen.

Nur der urspriingliche Projektstarter sollte andere Benutzer zu Teilnehmern
erkldren, damit es kein Chaos gibt. Die Teilnehmer kénnen sich auch gegen-
seitig hinauswerfen; lediglich den Projektstarter kann niemand I6schen.

Projekt als Teilnehmer 6ffnen

Im folgenden Beispiel méchte der Benutzer das Projekt mit dem Namen WirZusammen als
Teilnehmer 6ffnen.

B & Project: (None) » | R3.3.2 ~
Environment | & New Project... = ]
» ] ~ - ist =
P CPIM < Open Project... E Ust

"} Global Envirq Close Project

1 WirZusammen al

Files Plots testprojekt

1 = ]
i Install @ Clear Project List i
Name |Versi...
Project Options... 88,

User Library

darts Statistical Tools to Analyze Your 1.0



Zunachst ist das gewlinschte Projekt auszuwahlen, indem in der rechten oberen Ecke mit
einem Klick auf den Pfeil hinter Project das Meni aufgerufen wird. Dann wird Open Project
ausgewahlt.

Open Project

My Projects

Project Owner ? Project Sharing
WirZusammen & testuser4

|

|
Open project in new session | Open Project | Cancel

Der Tab Shared with Me zeigt alle Projekte, zu denen der Benutzer als Teilnehmer zugelassen
wurde. Der Benutzer wahlt das Projekt und klickt auf Open Project.

Aktive Teilnehmer erkennen

Tools  Help testuser4 Sessions (2)

% WirZusammen ~

Sowie ein anderer Benutzer gleichzeitig an diesem Projekt angemeldet ist, erscheint ein
Symbol oben im Fenster; verschiedene Farben stehen hier fiir verschiedene Benutzer.

2lp testuser4
% Wir,

testuser>5
1t

4 Last seen 1 minute ago

L

n\ Follow cursor

Bewegt man den Mauszeiger auf das Symbol, so erscheint ein kleines Fenster, in dem man
sehen kann, woran der andere Teilnehmer gerade arbeitet und wann er zuletzt aktiv war.



37 erstesScript.R*

L] Source onSave 4 / ~ ~“#Run %% < Source -

2 #Hey, du pappnase: Kommentare benétigen ein #!
3 print("Hello World")xx

Anderungen erscheinen sofort bei allen Teilnehmern. Hier stammt die erste Zeile von User 4,
die mittlere hat User 5 beigesteuert und die Funktion kommt von User 2.

Eine besondere Bedeutung kommt dem Kastchen Follow Cursor zu. Wird diese angeklickt, so

verandert sich das kleine Symbol n . Ab diesem Zeitpunkt wird dann die Cursorposition
des entsprechenden Teilnehmers fiir den eigenen Cursor ibernommen.

Diese Funktion ist sehr praktisch, wenn man sich etwas in einem Iéingeren
Script zeigen lassen méchte, da man sofort sieht, wo der andere
Teilnehmer Anderungen vornimmt.

Besonders hilfreich ist es, wenn die Teilnehmer untereinander
Sprechkontakt haben, z.B. per Telefon.

Ressourcenverwaltung

Im Unterschied zu HLR und HLR64 Gbernimmt der R-Server die Verwaltung und Zuteilung der
Ressourcen (Prozessoren, Speicher, Rechenzeit) selbst.

Alle Benutzer sind derzeit gleichberechtigt, es gibt lediglich die Ausnahme, dal} die RAM-
Verwendung auf 8 GB bei Kursteilnehmern und 16 GB bei anderen Benutzern limitiert ist.
Diese Begrenzung gibt es nur deshalb, damit ein evtl. Programmierfehler nicht
unbeabsichtigt zu einem Totalausfall des Systems fiihren kann.

Verschiedene Stellschrauben ermoglichen eine Optimierung des Systems, wobei es sich aber
stets nur um relative Veranderungen handelt, deren Auswirkungen bisher nicht genau
bekannt sind.

Es wird zundichst davon ausgegangen, dafs die Entwickler schon wissen,
was sie tun, und daher eine sinnvolle Voreinstellung abliefern.

Sollten sich die Voreinstellungen zu irgendeinem Zeitpunkt als problematisch herausstellen,
so kann im Gesprach mit dem Administrator versucht werden, eine Losungsmaglichkeit zu
erarbeiten.



Beispielsweise bendtigt ein Benutzer flir eine sehr umfangreiche
Matrixberechnung die kompletten 128 GB RAM; Lésung: am Wochenende,
auferhalb der Kurszeiten sollte das méglich sein.

R-Server und lokales R

Es ist problemlos moglich, daR der R-Server von einem Client genutzt wird, auf dem ein
lokales R installiert ist. Die Systeme beeinflussen sich nicht gegenseitig und kdnnten sogar
zeitgleich genutzt werden. Eine gemeinsame Benutzung von Paketen ist jedoch nicht
moglich.

von R-Studio empfohlene Browserversionen

* Mozilla Firefox ab Version 10

* Apple Safari ab Version 5.1

* Google Chrome ab Version 21

* Microsoft Internet Explorer ab Version 10

Bei den folgenden Versionen traten Probleme auf

* |E6/WindowsXP
* |E9/Windows7
* Firefox 14/SUSE Linux 12.2



